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 gif.* -الف 

 bmp.* -ب 

 dat.* -ج 

 jpg.* -د 

 ؟نادرست است Sleep درباره ریز ینه هایگز ک ازیکدام -338

 رد.یگ یر حالت آماده باش قرار موتر دینه کامپین گزیا یک بر رویکل با –الف 

 ابد.ی یبرق کاهش م ین حالت مصرف انرژیا در –ب 

 گردد. یبرم یوتر به حالت عادیحرکت ماوس کامپ اید ین حالت بازدن کلیا در –ج 

 گردد. یمصرف م یادیم و زمان زیندوز هستیستم ویس ین حالت ما مجبور به راه اندازیا در  -د 

 هم قرارگرفته و تنها نوار عنوان آنها قابل مشاهده باشد؟ یپنجره ها رو یشود که تمام یباعث م یزکدام روش مرتب سا -339

 SHOW WINDOWS STACKED (ی)به صورت پشته ا -الف 

 SHOW WINDOWS SIDE BY SIDE)به صورت مجاور هم(  -ب 

 CASCADE WINDOWS (ی)به صورت آبشار  -ج 

 Task Manager -د 

ها در یک پنجره باز انتخاب کدام گزینه باعث می شود تا پوشه Generalو تب  Folder Optionوره ای در کادر محا -340

 شوند؟

 Use Windows Classic Desktop -الف 

 Open Each Folder In The Same Window -ب 

 Open Each Folder In Its Own Window -ج 

 Enable All Web - Relate Content On My Desktop -د 

 ( به چه معنا است؟folderپوشه ) -341

 .است لیفا همان -الف 

                      ها برنامه و ها لیفا یسازمانده و ینگهدار یبرا یمحل -ب 

 ها برنامه به راحتتر و عتریسر یدسترس یبرا یکنیآ -ج 

 سخت سکید شینما یبرا یکنیآ -د 

 به چه معنا است؟ (file) لیفا -342

 ند.                              یگو یانه میه همه اطلاعات موجود در راب -الف 

 ل ها و برنامه هایفا یوسازمانده ینگهدار یبرا یمحل -ب 

 عتر و راحتتر به برنامه هایسر یدسترس یبرا یکنیآ -ج 

Highlight



 

 

 سک سختیش دینما یبرا یکنیآ -د 

 شود؟ یمهمجوار استفاده  یهاتمیانتخاب آ ینه برایکدام گز -343

 Alt -الف 

 Ctrl -ب 

 Home -ج 

                           Shift  -د 

 .ندیگو ..................... کار نوار یرو در رهیغ و بلندگو تیوضع ساعت، شینما هیناح به  -344

                   Notification -الف 

 Start button -ب 

 Gadgets -ج 

 Tasks -د 

 قرار دارند؟ یاهیچه ناح یدر حال اجرا بر رو یهابرنامه -345

                     Taskbar -الف 

 Menu -ب 

 Start -ج 

 Gadgets -د 

 برای کدام یک از دلایل زیر تهیه نسخه پشتیبان ضروری است؟ -346

 بروز مشکلات سخت افزاری -الف 

 از دست رفتن اطلاعات -ب 

 اجرای کند برنامه ها -ج 

 ابیروس ینصب و -د 

 برای تهیه نسخه پشتیبان از برنامه  .................  استفاده می شود. -347

 Disk Cleanup -الف 

 Scan Disk -ب 

                       Backup  -ج 

 Copy Disk -د 

 کدامیک از نرم افزارهای زیر می تواند برای فشرده سازی استفاده شود؟ -348

 Wordpad -الف 

 Notpad -ب 

 Acd See -ج 

                     Win Zipو  Win Rar  -د 

 م.یی.................... استفاده نما ید هایب کلیست از ترکیبدون پاسخ کاف یبستن برنامه ها یبرا -349

 Ctrl+alt -الف 

 Ctrl+alt+shift -ب 

                     Ctrl+alt+delete  -ج 

 Ctrl+shift -د 



 

 

350- Hibernate یعنی ....... . 

 .شود یگر فراهم مید یندوز با نام کاربری، امکان ورود به ویط کاربر فعلیبدون بستن مح -الف 

 کند. یانه را قفل میرا -ب 

 کند. یانه را خاموش میندوز خاتمه داده و رایبندد و به کار ویباز را م یه برنامه هایکل -ج 

کند. در صورت روشن کردن  یانه را خاموش میکند و را یره میسک سخت ذخید یر رودر حال اجرا را ب یه برنامه هایکل -د 

 دهد.                  یش میرا به همان حالت قبل نما یباز قبل یمجدد، برنامه ها

 دهد؟یانجام م یچه کار Sleepنه یگز -351

 کند.             یم یرا در حافظه نگهدار یت فعلیبدون بستن برنامه ها و پنجره ها وضع  -الف 

 .شود یگر فراهم مید یندوز با نام کاربری، امکان ورود به ویط کاربر فعلیضمن بستن مح -ب 

 .کند یانه را قفل میرا -ج 

 کند. یم یراه انداز کند و مجدداٌ یانه را خاموش میندوز خاتمه داده و رایبندد و به کار ویباز را م یه برنامه هایکل -د 

352- Shut down ست؟یچ 

 کند. یم یرا در حافظه نگهدار یت فعلیبدون بستن برنامه ها و پنجره ها وضع -الف 

 .شود یگر فراهم مید یندوز با نام کاربری، امکان ورود به ویط کاربر فعلیبدون بستن مح -ب 

 .کند یانه را قفل میرا -ج 

 کند.                           یانه را خاموش میداده و راندوز خاتمه یبندد و به کار ویباز را م یه برنامه هایکل  -د 

 م.یکن ی...... استفاده م یدهایباز از کل ین پنجره هایب ییجاجابه یبرا -353

 Alt+f4 -الف 

 Ctrl+Esc -ب 

                            Alt+Tab  -ج 

 Ctrl+Tab -د 

 ندوز قابل استفاده است؟یه ونیر زمیتصو یر برایل زیفا یک از فرمتهایکدام -354

  JPG -الف 

  Docx -ب 

  Pdf -ج 

  Dat -د 

 ر داد؟یی( را تغAttributesک پوشه )یتوان صفت  یم Propertiesاز کدام برگه در پنجره  -355

 Sharring -الف 

                          General -ب 

 Customize -ج 

 Hidden -د 

 .ی شودبرنامه باعث ................ مدوبار کلیک بر روی آیکن  -356

 اجرای برنامه  -الف 

 انتخاب برنامه -ب 

 باز شدن منوی میانبر -ج 

 افتد ینم یهیچ اتفاق -د 



 

 

 ند.یگو یکه دکمه سمت چپ آن فشرده است ........... م یبه عمل حرکت دادن موس در حال -357

 (Clickک )یکل -الف 

 کیراست کل -ب 

 ) Drag (دن یکش  -ج 

 (Double) کیدوبارکل -د 

 شوند؟ یسک سخت خاموش میتور و دیرد و مانیگ یوتر در حالت کم مصرف قرار میر کامپیک از حالات زیبا انتخاب کدام  -358

 Shut Down -الف 

 Sleep -ب 

 Restarting MS- Dos Mode -ج 

 Restart -د 

 ها باشد؟لیت فایتواند جزء خصوص یر میک از موارد زیکدام  -359

 Archive -الف 

 Read Only -ب 

 System -ج 

                     Properties  -د 

 ؟نیست حیصح هاانبریم مورد در ریز موارد از کی کدام -360

 .شوند یم استفاده ها برنامه عیسر یاجرا جهت -الف 

 .باشند یم فلش علامت کی یدارا انبرهایم -ب 

 ند.ینما یجاد میا Desktop در انبریم کی نصب از پس یبرد کار یها برنامه از یبعض -ج 

 با پاک شدن آن برنامه اصلی نیز پاک می شود.                          -د 

 .شود یاستفاده م ............... ید هایب کلیکبستن پنجره فعال از تر یبرا -361

 Alt+C -الف 

                       Alt+F4 -ب 

 Ctrl+C -ج 

 Alt+Esc -د 

 شود؟ یاستفاده م Personalizeنک در پنجره یکدام ل نه، ازیر طرح زمییتغ یبرا -362

 Screen Saver -الف 

 Apperance -ب 

 Setting -ج 

                    Desktop background  -د 

 کرد؟ انتخاب را پوشه کی یمحتوا کل توان یم دیکل بیترک کدام با -363

 Alt+C -الف 

 Alt+A - ب

                       Ctrl+A  -ج 

 Shift+A -د 

 م.یید ............. انتخاب نمایتور را باشد باینه انتخاب شده در مرکز صفحه مانینکه طرح زمیا یبرا -364



 

 

 Tile -الف 

                      Center -ب 

 Stretch -ج 

 Modify -د 

 د انتخاب نمود؟یرا با یکدام روش مرتب ساز (یار هم از چپ به راست )بصورت عمودش تمام پنجره ها در کنینما یبرا -365

              Show Windows side by side  -الف 

 Cascade Windows -ب 

 Show Windows stacked -ج 

 Minimal Windows -د 

 دهد؟ یوتر را در حالت آماده باش قرار مینه کامپیانتخاب کدام گز -366

 Shut down - الف

 Restart -ب 

 Switch User -ج 

                      Sleep  -د 

 انتخاب را ............... نهیگز شده باز یمنو از و نموده راست کیکل ویدرا کنیآ روی ها ویدرا خواص مشاهده یبرا  -367

 .میکن یم

 Label -الف 

                           Properties -ب 

 View -ج 

 Details -د 

 رد چه نام دارد؟یگ یکردن داخل آن قرار م Cutا ی یکه اطلاعات پس از کپ یحافظه موقت مجاز -368

 Copy -الف 

 Paste -ب 

 Rom -ج 

                            Clipboard  -د 

 د؟یکن یم انتخاب را ریمس کدام ستمیس خیتار و زمان میتنظ یبرا -369

 Date & Time  انتخاب و کار نوار یرو بر راست کیکل -الف 

 Date & Timeو انتخاب  Desktopصفحه  یک راست بر رویکل -ب 

 Start/setting/Date&Time -ج 

              Control Panel /Date &Time  -د 

 .میکن یم استفاده.................  نهیگز از شینما صفحه از محافظت یبرا -370

 Desktop Background -الف 

 Window color -ب 

                           Screen Saver  -ج 

 Sound -د 

 م.یکن ی.............. استفاده م لها ازیچاپ فا یبرا -371

Highlight



 

 

                        File/Print  -الف 

 Edit/Print -ب 

 Insert/Print -ج 

 View/ Print -د 

 رد؟یگ یم قرار استفاده مورد ندوزیو یها پنجره اتیمحتو مرورر جهت یز ینه هایک از گزیکدام  -372

                          Scroll Bar  -الف 

 Menu Bar -ب 

 Tool Bar -ج 

 Status Bar -د 

 د؟یکن یچگونه عمل م Desktop یانبر رویک میجهت فرستادن  -373

   Desktop(Create Shortcut)نه یتخاب گزو سپس ان Send Toنه یکن و انتخاب گزیآ یک رویراست کل  -الف 

 Floppyنه یو سپس انتخاب گز Send Toنهیگز انتخاب و کنیآ یرو کیکل راست -ب 

  Recipient Mailنهیو سپس انتخاب گز Send Toنه  یکن و انتخاب گزیآ یک رویراست کل -ج 

 Mail Recipientنه یو سپس انتخاب گز Send Toنه یکن و انتخاب گزیآ یک رویراست کل -د 

 باشد. یم ........... ید معادل فرمان کپیکل -374

                     Ctrl+C  -الف 

 Ctrl+V -ب 

 Ctrl+X -ج 

 Ctrl+A -د 

375- Task Barگردد؟ یندوز اطلاق میبه کدام قسمت و 

 پنجره یاصل یهامنو -الف 

 Desktopن یینوار کار پا -ب 

 تینوار وضع -ج 

 رنوار مرورگ -د 

 شوند؟ یم یاطلاعات حذف شده در کجا نگهدار -376

 Document  -الف 

 Microsoft Outlook -ب 

                     Recycle Bin  -ج 

 Cotrol Panel -د 

 و عکس عبارت است از: ) ازچپ به راست ( یصوت یلهایپسوند )فرمت( فا -377

 Wav- Mpb -الف 

 Doc- Bmp -ب 

                   Wav- Bmp  -ج 

 Bmp- Doc -د 

 کند؟ یپراکنده به ما کمک م یهاتمیر در انتخاب آیز یک از دکمه هایکدام -378

 Alt -الف 

Highlight



 

 

                         Ctrl -ب 

 Inc -ج 

 Tab -د 

379- "Restart" ......... است. کردن همان 

 کردن است Turn Off -الف 

 وتریراه اندازی مجدد کامپ -ب 

 خاموش مهیانه به حالت نیبردن را -ج 

 حالت انتظار است -د 

 ست ؟ی( چSceen Saverمنظور از ) -380

 یواریکاغذ د -الف 

 ندوزیش ویصفحه نما -ب 

 ش متحرکینما -ج 

 ش                    .یمحافظ صفحه نما  -د 

 م؟یت کنیریدو ها را مشاهده و میه درایم کلیتوان یم یابا ورود به چه پنجره -381

 Computer  -الف 

 Document -ب 

 Network -ج 

 Desktop -د 

 ست؟یچ یمتن یلهایپسوند )فرمت( فا -382

 Txt -الف 

 Wav -ب 

 Docx -ج 

 Txt & Docx  -د 

 . توان ............ یل میک فایجهت حذف  -383

 را اجرا نمود View/Deleteک و فرمان یآن کل یبر رو -الف 

 را انتخاب نمود Cutنه ید و گزیل مربوطه و از صفحه کلیفا یبر رو کلیک راست -ب 

 ش درگ نموده و در آنجا رها کردیاز صفحه نما یآن را گوشه ا -ج 

 را انتخاب نمود Deleteنه ید گزیل مربوطه و از صفحه کلیفا یبر رو کلیک -د 

 دهد؟ یرا انجام م یچه عمل Renameفرمان  -384

 کردن یکپ -الف 

 لیر فاین مسییعت -ب 

 یابیباز -ج 

                     ل و پوشه هایمجدد فا ینامگذار  -د 

 م؟یساز رهیذخ لیفا کی درون را مطالب میتوان یم چگونه ندوزیو یکاربرد های برنامه طیمح در -385

 File/Copy -الف 

 Edit/Save -ب 

Highlight

Highlight

Highlight



 

 

                        File/Save  -ج 

 Edit/Exit -د 

 ست؟یپ بورد چیکل -386

 وتریکامپ یحافظه جانب -الف 

 رد                یگ یکردن درون آن قرار م یکه داده ها بعد از کپ وتریاز حافظه موقت کامپ یبخش -ب 

 وتریکامپ یحافظه دائم -ج 

 تواند باشد ینه ها میبسته به مورد هر کدام از گز -د 

 م.یکنینه ................ را انتخاب میگزک کرده و یاست کلآن ر یل رویک فایت یمشاهده ظرف یبرا -387

 Size -الف 

 Properties -ب 

 Capacity -ج 

 Details -د 

 د کرد؟ین دو سطر نوشته شده چه بایب یجاد سطر خالیا یشگر متن برایرایو یدر برنامه ها -388

 میسطر اول بزن یرا در انتها Shiftد یکل -الف 

 میرا بزن Enterل را بلوک کرده و با ماوس خط او -ب 

 میرا بزن Deleteد یخط اول کل یدر انتها -ج 

 میرا بزن Enterد یسطر دوم کل یا ابتدایسطر اول  یدر انتها  -د 

 کند؟ ین اصلاح مرتب میدرون پنجره را بر اساس تاریخ آخر یکن هاینه آیکدام گز -389

 Auto Arrange -الف 

 Name -ب 

 Type -ج 

 Date Modified  -د 

 را یا نهیگز چه گردد، خاموش ستم به صورت کاملیس یکه برنامه ها باز بوده ول یستم در حالتیجهت قراردادن س -390

 د؟یکن یم انتخاب

 Turn Off -الف 

 Standby -ب 

 Sleep -ج 

 Hibernate  -د 

 است. د معادل فرمان انتقال ..............یکل -391

 Ctrl+X  -الف 

 Ctrl+V -ب 

 Ctrl+C -ج 

 Ctrl+A -د 

 گردد. یم رد، باعث ظاهر شدن .........ینگ یپنجره جا یات پنجره در فضایاگر محتو -392

 Status Bar -الف 

 Address Bar -ب 

Highlight



 

 

 Toolbar -ج 

  Scrollbars  -د 

 آن را اجرا کرد؟ یتوان به چه روشیل، میدر صورت عدم اطلاع از مکان فا -393

 Runدر پنجره  Browseه از دکمه استفاد -الف 

 Searchاستفاده از  -ب 

 My Computer -ج 

 ستین ین کار عملیا -د 

 م؟یکن یر استفاده میکدام مس از Wordpadط یدیگر در مح یر از نرم افزار هایقرار دادن تصو یبرا -394

 View/Object -الف 

 Edit/Object -ب 

 Insert/Object  -ج 

 File/Object -د 

 م؟ینه استفاده کنیستم شود بهتر است از کدام گزیوارد س یگریوتر قطع شود و کاربر دیبا کامپ ینکه ارتباط کاربر فعلیا یبرا -395

 Log Offانتخاب   -الف 

 sleepانتخاب  -ب 

 Turn Offاز پنجره   down shut انتخاب –ج 

 Hibernate -د 

 م ؟یکن یستفاده ما یریاز چه مس Windows Explorer یاجرا یبرا -396

 Computerفقط پنجره  -الف 

 است یندوز قابل دسترسیو یدر همه پنجره ها -ب 

 Windows Explorerکن یآ -ج 

 Cو یق درایفقط از طر -د 

 سک است؟یمربوط به دProperties  یا محاوره کادر در ویش کل درایر نشان دهنده گنجایز ینه هایک از گزیکدام  -397

 Capacity  -الف 

 Type -ب 

 Free Space -ج 

 Used Space -د 

ن حروف بزرگ و کوچک تفاوت یتوان در هنگام جستجو بیمWord Padافزار در نرم Findنه از پنجره یبا انتخاب کدام گز -398

 قائل شد؟

 Between -الف 

 Advanced -ب 

 Case Sensitive  -ج 

 During The Previous Day -د 

 گردد؟ یفه مینه باعث قفل شدن نوار وظیفه انتخاب کدام گزیمات نوار وظیتنظ یاز کادر محاوره ا -399

 Show Quick Launch -الف 

 Lock the taskbar -ب 

Highlight

Highlight

Highlight



 

 

 Auto Hide The Task Bar -ج 

 Hide Inactive icon -د 

 رد؟یگ یانبر آنها معمولا در کدام منو قرار میکن میهنگام نصب برنامه ها، آ -400

 Accessories یمنو -الف 

 All Program -ب 

 Accessories یاز منو System یمنو -ج 

 File -د 

 رود؟ ین اندازه کاغذ و نوع کاغذ بکار مییه ها، نوع کاغذ و تعیر حاشییجهت تغ Paintنه ها در نرم افزار یک از گزیکدام -401

 Page Setup  -الف 

 Save As -ب 

 Print Preview -ج 

 Open -د 

 م؟یکن یانتخاب م Sort منوی زیر از را مورد کدام شوند، مرتب آنها کن ها بر اساس نوعینکه آیا یبرا -402

 By Name -الف 

 By Data -ب 

 By Item Type  -ج 

 Auto Arrange -د 

 ح است؟ینه صحیم صدا کدام گزیبه منظور تنظ -403

 نوار کار یکن صدا بر رویآ یرو ک بریکل  -الف 

 All Program/Accessories/sound recorder -ب 

 Computer  -ج 

 Setting -د 

 شود؟ یم کار زیم در هاش آیکنیا عدم نمایش ینه باعث نمایکدام گز -404

 Auto Arrange -الف 

 Align To Grid -ب 

 Date Modified -ج 

 Show Desktop Icon  -د 

 شود. یاستفاده م .......نه ...یگز Start یکردن منو یبه منظور سفارش -405

 Taskbar &start menu Propertiesزکار /یم یک رویراست کل -الف 

 Start/Properties -ب 

 Computer  -ج 

 Propertiesو انتخاب  Desktop یک راست رویکل -د 

 م؟ید انتخاب کنیانه را بیم کدام گزیمنتقل شو یگرید Userم به یفعال بسته نشوند و بخواه ینکه پنجره هایا یبرا -406

 Standby -الف 

 Log Off -ب 

 Switch User  -ج 

Highlight



 

 

 Restart -د 

 .میکن یرا انتخاب م نه .........یرد گزیقرار گ Desktopدر  یکار ینه به صورت کاشیر زمینکه تصویا یبرا -407

 Tile  -الف 

 Stretch -ب 

 Center -ج 

 Position -د 

 م؟یکن ینه استفاده میستم از کدام گزیبه سگر یک زبان دیاضافه کردن  یبرا -408

 Control Panel \ Region And  Language\ Add Language   -الف 
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 ؟ است درست نهیگز کدام سرعت نیشتریب داشتن لحاظ از -700

 CPU > Ram>Hard> Floppy  -الف 

 CPU >Hard>Ram>Floppy -ب 

 Ram> CPU >Hard>Floppy -ج 

 Ram> CPU >Floppy>Hard - د

 باشد؟ ینه درست میکدام گز -701

 1MB=1024GB -الف 

 1Mb=1024 B -ب 

 1MB=1024KB -ج 

 1Gb=1024 Kb -د 

 ی.............. استفاده م ین جهت از حافظه هایباشد به هم ی............ م Ram یاز حافظه اصل CPUسرعت انتقال داده ها در  -702

 کنند.

 ثبات  - کمتر -الف 

 ثبات  -شتر یب -ب 

  Cache   - شتریب -ج 

 Cache  -کمتر  -د 

 باشد؟ یت درست مینه در مورد بایکدام گز -703

 یره قابل آدرس دهین واحد حافظه غیکوچکتر -الف 

 ین واحد حافظه قابل آدرس دهیکوچکتر -ب 

 ره کندیرا در خود ذخ1ا ی 0تواند  یفقط م -ج 



 

 

 دهد یل میرا تشکت یک بیت یبا 8هر  -د 

کنند .................  یگان از آن استفاده میورا یشیبه طور آزما یک مدت مشخصی یکه مصرف کننده برا ییبه  نرم افزارها -704

 شود؟ یگفته م

 گانیرا ینرم افزارها -الف 

 یاشتراک ینرم افزارها -ب 

 متن باز ینرم افزارها -ج 

 یشینما ینرم افزارها -د 

 باشد؟ یم نادرستنه یگز کدام -705

 سکید یره رویک دایار : یش -الف 

 شود یل میسک از چند قطاع تشکید یره رویقطاع : هر دا -ب 

 هم مرکز با شعاع برابر یره هایلندر : دایس -ج 

 هم مرکز با شعاع برابر یره هایقطاع : دا -د 

 رود؟ یانتقال صوت به کار م یر برایک از موار زیکدام  -706

 RAM - الف

 کارت صدا -ب 

 یکیگراف کارت -ج 

 مودم -د 

707- USER ID  همان ........ وPASSWORD  .همان ............... است 

 لینام و فام -الف 

 و حفاظت اطلاعات ینام کاربر -ب 

 و کلمه عبور ینام کاربر -ج 

 رمز وکلمه عبور -د 

 است ؟ 7 ندوزیو یها یژگیر از ویز ینه هایک از گزیکدام -708

 تک کاربره -الف 

 یمتن -ب 

 فهیتک وظ -ج 

 AERO  -د 

 هستند؟ یتابع ید هایر کلیز ینه هایک از گزیکدام -709

 CTRL -الف 

 ALT -ب 

 F 12تا F1  -ج 

 NumLock -د 

 ؟ کند ینمان یت حافظه را بیکدام واحد ظرف -710

 Db  -الف 

 Kb -ب 

 Gb -ج 
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 Mb -د 

 ند.ی................. گو پوتر رایکام یبرد اصل -711

 CPU -الف 

 Ram -ب 

 Hard -ج 

 Mainboard  -د 

 به کدام صورت است ؟ CD یسکهایبه اطلاعات د یدسترس -712

 یبیا ترتیگام به گام  -الف 

 یمواز -ب 

 یا تصادفیم یمستق -ج 

 ینور -د 

 است ؟ یچه منظور یغلطک وسط موس برا -713

 ک راست استیمعادل کل -الف 

 ک چپ استیمعادل کل - ب

 ندارد یکاربرد -ج 

 ات پنجره هایمرور محتو  -د 

714- Boot  چه ؟ یعنیشدن 

 نیماش یجانب یاز اجزا یکی یستم بعلت خرابیات سیمتوقف شدن عمل -الف 

 سکید یرو Boot Recordخراب شدن  -ب 

 ترکامپیو Romستم توسط برنامه موجود در یس یلهایک فایشدن اتوماتLoad  -ج 

 مختلف یم شدن برنامه هایل مقیپر شدن حافظه به دل -د 

 ند .یتخت  را ................گو یتور هایدراصطلاح کامپیوتر، مان -715

 LCD -الف 

 CGS -ب 

 CGA -ج 

 VGA -د 

 است؟ کدام عهده بر یستم کامپیوتریک سی یات درونیه عملیکل یفه کنترل و هماهنگیوظ -716

 یاربردک یها برنامه -الف 

 یستمیس یبرنامه ها -ب 

 یعموم یس دهنده هایسرو -ج 

 مترجم -د 

 ست؟یمخفف چ Itاصطلاح  -717

 است . ینترنتیا یفناور یاست وبه معنا Internet Technologyمخفف عبارت  -الف 

 اطلاعات است . یفناور یاست وبه معنا Inter Net Techologyمخفف عبارت  -ب 

 ارتباطات است . یفناور یاست و به معنا Information Technologyمخفف عبارت  -ج 

 اطلاعات است . یفناور یاست وبه معنا Information Technologyمخفف عبارت  -د 



 

 

 ف کامپیوتر است؟یر تعرینه زیک ازگزیکدام  -718

 طقی را انجام دهد.و من یاضیات ریکه قادر است عمل یزیحافظه و قابل برنامه ر یاست دارا یدستگاه -الف 

 دهد. یرا انجام م یو منطق یضیات رایاست که فقط عمل یدستگاه -ب 

 .دهد یرا انجام م ینیپ و حروفچیتا یاست که فقط کارها یدستگاه -ج 

 ایمد یل هایپخش فا یاست برا یدستگاه -د 

 رود؟ یت نرم افزار به شمار میر خصوصیک از موارد زیکدام -719

                          بل لمسو قا یکیزیف -الف 

 .است یکیو مکان یکیشامل مدارات الکترون -ب 

 جهت استفاده از کامپیوتر است . ییشامل دستور العملها -ج 

 فه پردازش اطلاعات را دارد.یوظ -د 

 کدام است ؟ یشخص یکامپیوتر ها یاصل یاجزا -720

 Cpu - Memory - Case - Monitor -الف 

 Cpu - Ram - Hard - Case - Monitor- Keyboard -ب 

 Cpu - Memory - In Put Unit - Output Unit -ج 

 Cpu - Memory - Keyboard - Case -د 

 ت ؟سینح یر صحیز ینه هایک از گزیکدام  -721

 .ن سخت افزار و نرم افزار و کاربر استیستم عامل رابطه بیس -الف 

 ه و تک کاربره باشد .ستم عامل ممکن است چند کاربریس -ب 

 .فه داشته باشدیک وظیا یفه یستم عامل ممکن است چند وظیس -ج 

 . سخت افزار هاست یراه انداز یستم عامل برایس -د 

 کند ؟ یم کامپیوتر وارد و کرده لیتبد تالیجیسیگنالهای در عکس را به یز یک از دستگاههایمکدا -722

 Touchpad -الف 

 Trackball -ب 

 Scanner -ج 

 Light Pen -د 

 ؟ است مناسب ریز یها نهیگز از کی کدام تیمگا با 500ل به حجم یک فای ییجابجا یبرا -723

 یقلم نور -الف 

 Rom -ب 

  Cd -ج 

  Floppy -د 

 .است  ................ یلهایمربوط به فا Waveو پسوند  .................... یلهایمربوط به فاTxtپسوند  -724

 یصوت - ییاجرا – الف

 یریتصو  - یمتن -ب 

 یصوت - یمتن -ج 

 یریتصو  - ییاجرا -د 

 است. ک دستگاه ..........................ی یقلم نور -725
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  یورود -الف 

 یخروج -ب 

 یخروج - یورود -ج 

 یسیسک مغناطید -د 

 باشد؟ یک میتجارت الکترون یاینه از مزایکدام گز -726

  عتهسا 24 خدمات -الف 

 تیعدم اعتمادبه وب سا -ب 

 ق کالایعدم مشاهده دق -ج 

 از کارت یکلاهبردار -د 

 چه نامیده می شود ؟ Ramو  Cpuمسیر عبور  اطلاعات بین  -727

 Port -الف 

 Slot -ب 

 Bus  -ج 

 Socket -د 

 گویند . ی................. م رنده اطلاعات ............ و به  رایانه ای که فرستنده اطلاعات استیانه گیبه را -728

 کانال انتقال Server -الف 

 Server -کانال انتقال  -ب 

 Server - Clients  -ج 

 کانال انتقال -Client -د 

 دارد ؟ یشتریر سرعت بیاز چاپگرهای ز کدامیک -729

 چاپگرهای سوزنی -الف 

  چاپگرهای لیزری -ب 

 چاپگرهای ضربه ای -ج 

 افشانچاپگرهای جوهر  -د 

 ؟ مضر نداردکدام صفحه نمایش تششعات  -730

 CRT -الف 

 LCD . CRT -ب 

 Plasma . LCD -ج 

 CRT. Plasma -د 

 ؟ نیستکدام یک از کلید های زیر دو حالته  -731

 Caps Lock -الف 

 Num Lock -ب 

 Scroll Lock -ج 

 Shift -د 

 شود. ی................ استفاده م د ازیبه منظور فعال نمودن اعداد سمت راست صفحه کل -732

 Caps Lock -الف 
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 Scroll Lock -ب 

 Num Lock -ج 

 Shift -د 

 ...................... را فعال نمود. د دکمهین بایپ حروف بزرگ لاتیتا یبرا -733

 Caps Lock -الف 

 Scroll Lock -ب 

 Num Lock -ج 

 Ctrl -د 

 ش عکس گرفت.یتوان از صفحه نما ی.............  م با استفاده از دکمه -734

 Caps Lock -الف 

 Print Screen -ب 

 Num Lock -ج 

 Scroll Lock -د 

 . ......... رقابل توقفیغ یبه منبع انرژ -735

 USB -الف 

 POWER -ب 

 UPS -ج 

 FLASH -د 

736- PDA چیست ؟ 

 ار بالایی دارد .از انواع کامپیوتر های شخصی است که سرعت بسی -الف 

 از انواع کامپیوترهای شخصی است که ابعاد بسیار بزرگی دارد . -ب 

 از انواع کامپیوترهای شخصی است که ابعاد کوچکی دارد و برای کارهای با حجم زیاد استفاده می شود . -ج 

 ستفاده می شود.از انواع کامپیوتر های شخصی است که ابعاد کوچکی دارد و برای کارهای با حجم کم ا -د 

 م ؟یکن ینه استفاده میاز کدام گز ین تعداد ارقام اعشارییتع یبرا -737

 Insert -الف 

 Edit -ب 

 Home- number  -ج 

 Format -د 

 د انتخاب کرد ؟ینه را بایکدام گز  Print یاز کادر محاوره ا یجار یچاپ صفحه کار یبرا -738

 Selection Print -الف 

 Entire Work Book Print -ب 

  print Active Sheet  -ج 

 Print Current Sheet -د 

 ست ؟ی= چRound( 1;435.23جه تابع )ینت -739

 435 -الف 

 435.231 -ب 

Highlight

Highlight

Highlight



 

 

 435.2 -ج 

 435.23 -د 

 م؟یکن استفاده یا نهیگز چه از شده فیتعر سبک ادغام یبرا -740

 Modify  -الف 

 table style -ب 

 style  Merge -ج 

 add -د 

 ن شود ؟یید تعیرد در کدام مورد باینکه نمودار در همان صفحه قرار گیا یبرا -741

 As New Sheet -الف 

 object in -ب 

 As New Work Book -ج 

 File - New -د 

 رند ؟یگ یبه چه منظور مورد استفاده قرار م  Pasteو  Copyن یفرام -742

 حذف اطلاعات -الف 

 عاتاطلا یکپ -ب 

 اطلاعات ییجاجابه -ج 

 ن فرمان و برگرداندن دوبارهیحذف آخر -د 

 شود؟ ینه استفاده مید کدام گزیک سبک جدیجاد یا یبرا Homeاز سربرگ  Cell Style یاز کشو -743

 م .یکن یک میکل Addدکمه  ی، بر رون نام سبکییبعد از تع -الف 

 م .یکن ین مییپس نام سبک را تعک کرده وسیکل new cell styleنه یگز یبر رو -ب 

 م .یکن یک میکل newدکمه   یبر رو -ج 

 م .یکن یک میکل Okدکمه   ین نام سبک ، بر روییبعد از تع -د 

 شود؟ ینه استفاده میست از کدام گزیک لیمرتب کردن  یبرا -744

 Dataاز تب  Autofilter نهیگز –الف 

 .مینک یانتخاب م Dataرا از تب  Formنه یگز -ب 

 م.یکن یانتخاب م Dataرا از تب  Arrangeنه یگز -ج 

 م.یکن یانتخاب م Dataرا از تب  Sortنه یگز  -د 

 ک از انواع برنامه هاست ؟یر مجموعه کدام یز Excelبرنامه  -745

 واژه پردازها -الف 

 یمیترس یبرنامه ها -ب 

 یاطلاعات یها بانک  -ج 

 صفحه گسترده یبرنامه ها -د 

 کدام سلول به طور پیش فرض فعال خواهد شد؟ Enterد یو فشار کل B1س از ورود داده در سلول پ -746

 A1سلول  -الف 

 C1سلول  -ب 

 B2سلول  -ج 



 

 

 A2سلول  -د 

 شود ؟ یک سلول با خطوط هاشور میموجب پر شدن  Format Cellنه از کادر یکدام گز -747

 Gridlines -الف 

 Customize -ب 

 Texture -ج 

 Pattern  - د

 دهد ؟ یرا انجام م یچه کار  Deleteاز پنجره  entire row نهیگز -748

 کند. یسلول انتخاب شده را پاک م -الف 

 کند . یات سلول را پاک میفقط محتو -ب 

 کند . یک سطر را به طور کامل پاک می -ج 

 کند . یک ستون را به طور کامل پاک می -د 

 در سلول فعال کدام مورد درست است ؟ C3 تا B2 یسلولها یجمع کردن محتوا یبرا -749

 B2+C3 -الف 

 B2+C3= -ب 

 B2+C2+B3+C3 -ج 

 =B2+C2+B3+C3 -د 

 ؟باشد  ینم Excel یکاربردها از نهیگز کدام  -750

 یزیانجام امور نشر روم -الف 

 یه دفاتر حسابداریته -ب 

 یکیه نمودار گرافیته -ج 

 فاکتور فروش -د 

 شود ؟ یر استفاده مینه زی)اضافه کردن( کاربرگ از کدام گز ظور درجبه من -751

 Insert Column -الف 

 Insert Sheet -ب 

 Insert Row -ج 

 Insert Delete -د 

 ست ؟یچ Data Labelsنه یم نمودار مفهوم گزیدر ترس -752

 ها داده ش مقدارینما  -الف 

 نمودار در ها داده جدول شینما -ب 

 نمودار رحش شینما -ج 

 محورها و نمودار عنوان -د 

 دارد؟ یفه ایچه وظCount  تابع -753

 انتخاب شده یشمارش سلولها -الف 

 پ شدهیتا یشمارش سلولها -ب 

 یعدد یشمارش سلولها  -ج 

 متن یحاو یشمارش سلولها -د 
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 شود ؟ یر به عنوان متن در نظر گرفته میز ینه هایک از گزیکدام  -754

 4.3 -الف 

 =3+2 - ب

 3+2  -ج 

 10:30 -د 

 شود؟ ینه استفاده میم نمودار در یک صفحه جدید کدام گزیترس یبرا -755

 Chart Typeنه یانتخاب گز -الف 

 As New Sheetنه یانتخاب گز -ب 

 Place Chartنه  یانتخاب گز -ج 

 In As Objectنه یانتخاب گز -د 

 ر است ؟یز ینه هایگزک از یمعادل کدام Sum(A1:A10)/10فرمول = -756

 Round (A1,A10)= -الف 

 Averege (A1:A10)= -ب 

 Subtotals (A1:A10)= -ج 

 Count (A1:A10)= -د 

 م ؟یکن ینه استفاده میدر سلولها از کدام گز یتکرار یع عمل پر کردن داده هایجهت تسر -757

 Auto Correct -الف 

 Auto Format -ب 

 Auto Stayl -ج 

 Auto Fill  -د 

 ست ؟یچ sum(A2:C5;D8)=  فه دستوریوظ -758

 D8و سلول  C5تا  A2 یمحاسبه مجموع سلولها -الف 

 D8و سلول  C5با A2 یمحاسبه مجموع سلولها -ب 

 D8 تا C5 یو سلولها A2محاسبه مجموع سلول  -ج 

 D8 تا A2محاسبه مجموع سلول  -د 

 ح است ؟ینه صحیکدام گز -759

 A1=A2+A3 -الف 

 =A2+A3 -ب 

 A2+A3= -ج 

 A2=A3 -د 

 توان استفاده کرد ؟ید میش خانه فعال از کدام کلیرایو یبرا -760

 F3 -الف 

 F1 -ب 

 F2  -ج 

 F4 -د 

 توان ............ . یحدوده مشخص مک میانتخاب  یبرا -761



 

 

 را زد . Ctrl سپس خانه اول را انتخاب و -الف 

 م .یریگ یرا م Altن خانه  یانتخاب اول -ب 

 م .یکن یک میرا کل ییرا گرفته و خانه انتها Shiftم و سپس یکن یخانه اول را انتخاب م -ج 

 و انتخاب خانه ها ید جهتیکل -د 

 داده ها را  در خانه ها  انجام داد ؟ یتوان هم تراز یم Format Cellsبا استفاده از کدام تب از  -762

 Number -الف 

 Font -ب 

 Alignment  -ج 

 Border -د 

 دهد؟ یانجام م یچه عمل Shrink To Fitنه یگز Alignmentاز تب  Format Cellدر کادر  -763

 رد .یگ یشود تا در طول خانه جا یاس داده میر مقییتغ یمتن نوشته شده در خانه طور -الف 

 ک خانهیشده در  یخانه ها  یب محتوایترک -ب 

 رد  .یگ یه متن در خط بعد قرار میبقشتر باشد یاگر طول متن از خانه ب -ج 

 کند یده شدن متن تا عرض خانه را پر میکش -د 

 نه ........... .یاز گز یتکرار یهااز انجام کار یریبالا بردن سرعت انجام کارها و جلو گ یبرا -764

 Merge -الف 

 Template -ب 

 Style -ج 

 Styleو  Template -د 

 رود؟ یبه چه منظور بکار م Reviewتب از  Protect Sheetنه یگز -765

 خودکار یابیغلط  -الف 

 یصفحه جار یرو یرمز گذار -ب 

 Work Book یرو یرمز گذار -ج 

 اطلاعات کاربر به اشتراک گذاشتن -د 

 ح است؟ینه صحیکدام گز یه مشاهده نمودار سه بعدیر زاوییتغ یبرا -766

 Chart Typeنه یگز Chartاز تب  -الف 

 Chart Optionنه یگز Chartب از ت -ب 

 3d- viewنه یگز Chartاز تب  -ج 

 Locationنه یگز Chartاز تب  -د 

 max(A1,B1,F3)=ر کدام است ؟       یباشد حاصل تابع ز  F3=4و   A1=Trueو  B1=Khاگر  -767

 Khtrue4 -الف 

 صفر -ب 

 Error -ج 

  4 -د 

 جام دهد ؟چند تابع را انر تواند کا یکدام دستور م -768

 Sum -الف 
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 Subtotals -ب 

 Average  -ج 

 Form -د 

 د انتخاب کرد؟یکدام مورد را با Print یچاپ کل سند از کادر محاوره ا یبرا -769

 Active SheetS -الف 

 Entire Work Book -ب 

 Selection -ج 

 List -د 

 یم بر را یعدد چه روبرو تابع باشد 24 -18 -10 -16 -14 -8 ن اعدادییب از بالا به پایبه ترت d6تا  d1ریاگر مقاد -770

 max(d1:d5)= گرداند؟

 24 -الف 

 8 -ب 

 16 -ج 

 18  -د 

 ؟ح نیستیصحر یکدام مورد ز -771

 که بتوان در آن داده وارد کرد . یهر صفحه ا یعنیکاربرگ  -الف 

 دهد  . یل میرا تشک یک صفحه کاریتقاطع هر سطر و ستون  -ب 

 سطر نامند. یمجاور هم را بطور افق یاه سلول –ج 

 ، زمان نام برد .خی، تاری، متنیتوان عدد یسلول را م یخلر دایانواع مقاد -د 

 ؟ ستیح نیصحکدام مورد  یره کردن اطلاعات در داخل صفحه کاریدر مورد ذخ -772
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 Columnar -الف 

 Tabular -ب 

 Data Sheet -ج 

 Auto Wizard -د 

 ؟Tabularصورت با ایجاد فرم به  -911

 می توانیم فرم را به صورت جدولی از فیلدها در رکوردها داشته باشیم . -الف 

 می توانیم نوعی فرم ستونی ایجاد کنیم . -ب 

 می توانیم فرمهای معمولی ایجاد کنیم . -ج 

 نمی توانیم فرمهای معمولی ایجاد کنیم -د 

 ؟نیست کدامیک از بخشهای اصلی فرم  -912

 Detail -الف 

 Form Header -ب 

 Form Footer -ج 

 Form View -د 

 کدام انتخاب نوع فرم را ستونی ایجاد می کند ؟ -913

 Tabular -الف 

 Columnar -ب 

 Form Wizard -ج 

 Data Sheet -د 

 ........ می گویند . استخراج اطلاعات و داده های خواسته شده از یک بانک اطلاعاتی و ارائه آنها برای استفاده را -914

 Table -الف 

 Page -ب 

 Query -ج 

 Macro -د 

 بکار می روند ؟Query  یو طراح کدامیک از معمولی ترین نماها برای مشاهده -915
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 Data Sheet Viewنمای  -الف 

 Design View -ب 

 Design Viewو  Data Sheet Viewنمای  -ج 

 Data Type View -د 

 شود؟ یر استفاده میا زیک از اشیاز کدام  یانجام شده در بانک اطلاعات یات تکراریعمل جهت استفاده از -916

 Tables -الف 

 Reports -ب 

 Macro -ج 

 Queries -د 

 دارا بودن هردو شرط عملگر بین آنها ، کدام است ؟ یبرا نوشته شود، Criteriaهنگامی که دو عبارت شرطی در  -917

 Not -الف 

 Xor -ب 

 And -ج 

 Or -د 

 کدام نوع مرتب سازی صعودی است ؟ -918

 Ascending -الف 

 Descending -ب 

 Grouping -ج 

 Sorting -د 

 در هنگام ایجاد گزارش ، چه چیز را تعیین می کنیم ؟ Orientationدر قسمت  -919

 صعودی و نزولی بودن رکوردها -الف 

 جهت چاپ گزارش بر روی کاغذ -ب 

 وردهاگروه بندی رک -ج 

 نوع گزارش -د 

 کدام یک از توابع زیر در طراحی گزارش ، میانگین اعداد را محاسبه می کند ؟ -920

 Count -الف 

 Sum -ب 

 Maximum -ج 

 Average -د 

 در هنگام ایجاد گزارش استفاده می کنیم ؟ یاز چه قسمت اگر بخواهیم لیست کارمندان بر اساس استان دسته بندی شود، -921

 Orientation -الف 

 Group -ب 

 Order -ج 

 Layout -د 

 چاپ می شود ؟یکبار در ابتدای گزارش کدام ناحیه از گزارش فقط  -922

 Page Footer -الف 

Highlight



 

 

 Report Footer -ب 

 Report Header -ج 

 Page Header -د 

 کدام کنترل زیر در طراحی گزارش برای نمایش متن فیلدها استفاده می شود ؟ -923

 Text Box - الف

 Lable -ب 

 Image -ج 

 Line -د 

 شود ؟ ید استفاده میانتخاب کلمات همجوار و پشت سر هم از کدام کل یبرا -924

 Ctrl -الف 

 Alt -ب 

 Tab -ج 

 Shift  -د 

 توان استفاده کرد؟ یر مینه زیانتخاب چند خط از کدام گز یبرا -925

 یجهت یدهایهمراه با کل Altد یکل -الف 

 دن ماوس به طرف انتهایک کردن بر مبدا و کشیلک -ب 

 Altد یک و درگ ماوس و انتخاب کلمات همراه با فشردن کلیکل -ج 

 یجهت یدهایهمراه با کل Ctrlد یکل -د 

 م ؟یکن یکدام زبانه را انتخاب م  Symbol یژه از کادر محاوره ایو یدرج کاراکترها یبرا -926

 Special Characters -الف 

 Symbol -ب 

 Insert  -ج 

 Shortcut -د 

 م؟یکن ینمادها از کدام دکمه استفاده م یانبر براید میکردن کل یانبر در کادر سفارشید میحذف کل یبرا -927

 Assign -الف 

 Reset All -ب 

 Remove  -ج 

 Close -د 

 توان: یرا م Wordر نما در ییتغ یروش ها -928

 فعال کرد Viewاز زبانه   -الف 

 فعال کرد  Reviewاز زبانه  - ب

 ط نرم افزار قرار دارد فعال کردیکه در سمت چپ  مح ییق دکمه هایاز طر -ج 

 آن را فعال کرد  File یق منویتوان از طریم -د 

 ر داد؟ییتوان نماها را در ورد تغیاز کدام روش م -929

 قرار دارند Wordط ین و سمت راست محییکه در گوشه پا ییق دکمه هایاز طر  -الف 

 توان فعال کرد یم Showگروه  Viewانه یاز ز -ب 
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 توان فعال کردیم Insertاز زبانه  -ج 

 قرار دارند wordط ین و سمت چپ محییکه در گوشه پا ییق دکمه هایاز طر -د 

 رد؟یگ یک سبک از کدام روش صورت میانتخاب  -930

 Homeاز زبانه  Styleانتخاب   -الف 

 Reviewاز زبانه  Styleانتخاب  -ب 

 Designاز زبانه  Styleانتخاب  -ج 

 Viewاز زبانه  Styleانتخاب  -د 

 شود ؟ یخط کش چگونه عمل م یاز رو  Tabک یحذف  یبرا -931

 میکن یرون از خط کش درگ میتب مورد نظر را به ب  -الف 

 میده یرا فشار م Deleteد یتب مورد نظر اشاره کرده و کل یبر رو -ب 

 م یکن یک میکل Createدکمه  یپس از انتخاب تب مورد نظر بر رور Tabs یاز کادر محاوره ا -ج 

 م ینیگز یرا بر م Remove Tabنه یگز Tabs یاز کادر محاوره ا -د 

 شود ؟ یخط کش چگونه عمل م یاز رو  Tabک یحذف  یبرا -932

 میکن یم د حذفیاز صفحه کل Backspaceد یتب مورد نظر را با کل -الف 

 میده یرا فشار م Deleteد یتب مورد نظر اشاره کرده و کل یبر رو -ب 

 م یکن یک میکل  Clearدکمه  یپس از انتخاب تب مورد نظر بر رور Tabs یاز کادر محاوره ا  -ج 

 م ینیگز یرا بر م Remove Tabنهیگز Tabs یاز کادر محاوره ا -د 

 کند؟ یمتن انتخاب شده از حروف کوچک استفاده م ین کاراکتر تمام واژه هایاول یبرا Change Caseنه از یکدام گز -933

 Uppercase -الف 

 Title Case -ب 

 Lowercase -ج 

 Toggle Case  -د 

 نه مناسب است ؟یکدام گز Wordاصلاح خودکار متن ها در  یبرا -934

 Auto Format -الف 

 Auto Correct -ب 

 Auto Select -ج 

 Auto Change -د 

 م.یکن ینه ............................... را انتخاب میاز سربرگ ........................ گز یو گرامر ییاملا یابیخطا یبرا -935

 Home > Spelling -الف 

 View > Grammar -ب 

 Review > Spelling & Grammar  -ج 

 Insert > Spelling & Grammar -د 

 توان : یح آن میتصح یشود برا یده میک خط قرمز موج دار کشیر کلمه یکه در ز یهنگام -936

 ک کرده و خط موج دار را حذف نمودیآن دوبار کل یرو -الف 

 دینیانبر بر گزیم یرا از منو یادشنهیپ یهااز واژه یکیک راست نموده و یآن کل یرو -ب 

 مینیگز یرا بر م Formatنه یک راست کرده و گزیکلمه کل یرو -ج 
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 میفشار یرا م  Deleteم و دکمه یکن یکلمه را انتخاب م -د 

 توان: یح آن میتصح یشود برا یده میک خط قرمز موج دار کشیر کلمه یکه در ز یهنگام -937

 دییک کرده و خط موج دار حذف نمایآن دوباره کل یرو -الف 

 مینیگز یرا بر م Changeنه یک راست نموده و گزیآن کل یرو -ب 

 دینیرا برگز  Autocorrectو   Ignore All ینه هایاز لغات گز یکیک راست نموده و یآن کل یرو -ج 

 م یفشار ید میرا از صفحه کل caps lockکلمه را انتخاب و بعد دکمه  -د 

 ست ؟ یر کلمه به چه معنیخط قرمز در ز -938

 دارد یکلمه مشکل گرامر -الف 

 دارد یکلمه مشکل نوشتار -ب 

 ه مشکل فرمت داردکلم -ج 

 ش استیرایرقابل ویکلمه غ -د 

939- Fixed Column Width  ه یواقع در ناحAuto fit  دهد؟ یانجام م یچه عمل 

 م شود.یتنظ ینیجدول برابر با طول مع یه سطرهایدهد که طول کل ین امکان را میا -الف 

 .م کندیتنظ ینیا طول معجدول را برابر ب یه سطرهایکل یدهد که پهنا ین امکان را میا -ب 

 .م کندیتنظ ینیجدول را برابر با طول مع یه ستون هایدهد که طول کل ین امکان را میا -ج 

 م کند.یتنظ ینیجدول را برابر با طول مع یه ستون هایکل یدهد که پهنا ین امکان را میا  -د 

 است؟ حیم صحیجاد جدول به روش ترسینه ها در رابطه با ایک از گزیکدام -940

 Tableاز سربرگ  Insertنه یانتخاب گز -الف 

 Homeاز سربرگ  Tableنه یانتخاب گز -ب 

 Tableاز سربرگ  Draw Tableنه یانتخاب گز -ج 

 Tableگروه   Insertاز سربرگ  Draw Tableانتخاب   -د 

 یسطرها سطر در ........... Layout ،5از سربرگ  Insert Belowنه یک جدول و انتخاب گزیسطر آخر  5با انتخاب  -941

 .شود  یجاد میشده اانتخاب 

 بالا -الف 

 نییپا -ب 

 سمت راست -ج 

 سمت چپ -د 

 یسطر در ................. سطرها Layout ،5از سربرگ   Insert Aboveنه یک جدول و انتخاب گزیسطر آخر  5با انتخاب  -942

 .شود یجاد میانتخاب شده ا

 بالا -الف 

 نییپا -ب 

 سمت راست -ج 

 سمت چپ -د 

انتخاب  ی............ سطرها سطر در Layout ،5از سربرگ  Insert Rightنه یک جدول و انتخاب گزیسطر آخر  5با انتخاب  -943

 .شود یجاد میاشده 

 بالا -الف 
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Highlight

Highlight

Highlight



 

 

 نییپا -ب 

 سمت راست -ج 

 سمت چپ -د 

انتخاب  یسطر در ............. سطرها Layout ،5از سربرگ  Insert Leftنه یک جدول و انتخاب گزیسطر آخر  5با انتخاب  -944

 شود. یجاد میشده ا

 بالا -الف 

 نییپا -ب 

 سمت راست -ج 

 سمت چپ  -د 

 شود؟ یاستفاده م یم جدول با استفاده از مداد از چه دستوریترس یبرا -945

 Insert table -الف 

 Quick Table -ب 

 Draw Table  -ج 

 Write Table -د 

 م؟یکن یبدون کادر از کدام دستور استفاده م یجدول به نوشته ها یل نوشته هایتبد یبرا -946

 Repeat Header Rows -الف 

 Convert to Text -ب 

 Convert to table -ج 

 Convert to Formula -د 

 ح است؟یصحک شکل پس از انتخاب آن شکل یر اندازه ییر جهت تغیک از موارد زیکدام  -947

 سر 4کان یپ -الف 

 سر 2کان یپ -ب 

 شکل یره بالایدا -ج 

 Borderدستور  -د 

 ح است؟یر صحیک از مراحل زیجهت چرخاندن اشکال کدام  -948

 Insert - > Rotate -الف 

 View - > Rotate -ب 

 Home - > Rotate -ج 

 Format - > Rotate  -د 

 م؟یکن یک سند از کدام فرمان استفاده می متن یشمارش تعداد کاراکترها یبرا -949

 View یاز منو Word Countفرمان  -الف 

 Review یاز منو Word Countفرمان  -ب 

 Home یاز منو Word Countفرمان  -ج 

 References یاز منو Word Countفرمان  -د 

 کدام است ؟ Subscriptانبر دستور ید میکل -950

 + ( Ctrl -الف 
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 + = Ctrl -ب 

 + = Ctrl + Shift -ج 

 + ] Ctrl -د 

 توان استفاده کرد؟ یجاد سرصفحه و پاصفحه از کدام زبانه میا یبرا -951

 Home -الف 

 Insert -ب 

 View -ج 

 Design -د 

 ن نمود.ییتوان سبک خط دلخواه کادر را تع یبا استفاده از قسمت ........ م border and shading یدر کادر محاوره ا -952

 Color -الف 

 Art -ب 

 Box -ج 

 Style  -د 

 شود؟ یانتخاب کل سند استفاده م یبرا یبید ترکیاز کدام کل -953

 Ctrl + Click -الف 

 Ctrl + Shift + Click -ب 

 Ctrl + End -ج 

 Ctrl + A  -د 

 شود؟ یاستفاده م یبید ترکیره سند از کدام کلیذخ یبرا -954

 Ctrl + o -الف 

 Ctrl + Shift + S -ب 

 Ctrl + S  -ج 

 Ctrl + P -د 

 شود؟ یوارد کردن فرمول در سند از کدام دکمه استفاده م یبرا -955

 Symbol -الف 

 Equation -ب 

 Formula -ج 

 Comment -د 

 شود؟ یاستفاده م یدیب کلید از چه ترکیشکستن متن و رفتن به صفحه بعد با استفاده از صفحه کل یبرا -956

 F2 -الف 

 Ctrl + V -ب 

 Ctrl + Enter  -ج 

 Ctrl + S -د 

 شود؟ یسند از کدام دکمه استفاده م یه هایم حاشیتنظ یبرا -957

 Column -الف 

 Margins -ب 



 

 

 Size -ج 

 Orientation -د 

 شود ؟ ینه استفاده میافزودن کادر به صفحه از کدام گز یبرا -958

 Insert - > Page Break -الف 

 home- > Page Border -ب 

 Design - > Page Border -ج 

 Page Setup - > Line number -د 

 کدام است؟ Word یالگوها یره سازیذخ یش فرض براینام پوشه پ -959

 Templates -الف 

 Documents -ب 

 Microsoft Word -ج 

 Program File -د 

 ؟شود یجدول از کدام دکمه استفاده م یادغام سلول ها یبرا -960

 Split Cells -الف 

 Split Table -ب 

 Merge Cells -ج 

 Merge Table -د 

 شود؟ یانتخاب م  Wrap Textخشینه از یرد کدام گزیر پشت متن قرار گینکه تصویا یبرا -961

 Tight -الف 

 Square -ب 

 Behind Text -ج 

 Through -د 

 م.یکن یدستور ......................... را اجرا مدرج شماره صفحه از زبانه ...................  یبرا -962

 Page Number- Design -الف 

 Page Number- Review -ب 

 Page Number- Home -ج 

 Page Number- Insert -د 

 م؟ینیگز ینه را بر میک راست کدام گزیر کلمه بعد از کلیده گرفتن خط قرمز زیناد یبرا -963

 Add to Dictionary -الف 

 Ignore - ب

 Deny -ج 

 Cancel -د 

 م ؟ینه را انتخاب کنید کدام گزیر کلمه اشتباه و تمام کلمات مشابه آن بایده گرفتن خط قرمز زیناد یبرا -964

 Ignore -الف 

 Ignore total -ب 

 Ignore All -ج 



 

 

 Deny -د 

965- Blank page  از گروهPages دارد؟ یچه کاربرد 

 کند. یمدرج  یک صفحه خالی -الف 

 کند یجاد میسند ا یک کاور برای -ب 

 رود یبه صفحه بعد در سند م -ج 

 کند. یجادمیک سند الگو ای -د 

 ست؟یچ Pagesدر گروه  Page Breakکاربرد دستور  -966

 کند. یدرج م یک صفحه خالی -الف 

 .کند یجاد میسند ا یک کاور برای -ب 

 .کندیند را قطع مس یشده و مابقان بخش انتخابیارتباط م -ج 

 کند. یجاد میک سند الگو ای -د 

 م؟یکن یچگونه عمل م Wordاستفاده از صفحه جلد در نرم افزار  یبرا -967

 cover page دستور editingگروه  Homeزبانه  -الف 

 Cover Pageدستور  Pagesگروه  Insertزبانه  -ب 

 Cover Pageدستور  Page Layoutزبانه   -ج 

 Cover Pageدستور  Page Borderگروه   Design زبانه -د 

 د؟یکن یاستفاده م Wordدر  یهوشمند از چه دستور یهنر یدرج جلوه ها یبرا -968

 Word Art -الف 

 Screenshot -ب 

 Shape -ج 

 Smart Art -د 

 شوند؟ یده میچه نام Wordافزار ها در جدول نرمستون -969

 Columns -الف 

 Rows -ب 

 Cells -ج 

 Table -د 

 شوند؟ یده میجدول چه نام یسطرها -970

 Cells -الف 

 Columns -ب 

 Rows -ج 

 Table -د 

 شود. یک ................... گفته میبه هر خانه جدول  -971

 Rows -الف 

 Columns -ب 

 Table -ج 

 Cell -د 



 

 

 م؟یکن یعمل م یروشجاد به چه یوارد کردن تعداد سطر و ستون جدول در زمان ا یبرا -972

 Insertاز زبانه  Draw Table -الف 

 Insert Tableو انتخاب  Insertاز زبانه  Table یک رویکل -ب 

 Insertاز زبانه  Input Table -ج 

 Homeاز زبانه  Insert Table -د 

 م ؟یکن یتعداد سطر را وارد م  Insert Tableدر کدام بخش از کادر محاوره  -973

 Number of Columns -الف 

 Fixed Column width -ب 

 Number of Rows -ج 

 Number of Cells -د 

 شود؟ یش داده مینما ییک جدول چه زبانه هایجاد یبعد از ا -974

 Format, Layout -الف 

 Table, Design -ب 

 Design, Table -ج 

 Design, Layout -د 

 ر؟یا خیکه جدول ما سطر عنوان داشته باشد  میکن ین مییتع Designانه یدر کدام بخش از ز -975

 Banded Rows -الف 

 Header Row -ب 

 Total Row -ج 

 Last Row -د 

 م؟ینیم اطلاعات سند را ببیتوان یم Fileدر کدام قسمت زبانه  -976

 INFO -الف 

 SHARE -ب 

 EXPORT -ج 

 ACCOUNT -د 

 صفحات سند را چاپ کرد؟ توان تمام یم Printدستور  ینه هایک از گزیکدام -977

 Print Preview -الف 

 Print All Page -ب 

 Print Selection -ج 

 Print Current Page -د 

 م؟یکن یم فقط صفحات زوج چاپ شود چگونه عمل میاگر بخواه -978

 Odd Page -الف 

 Print All Page -ب 

 Even Page -ج 

 Print Current Page -د 

 شود؟ یصفحات چاپ از کدام دستور استفاده مکردن  یسفارش یبرا -979



 

 

 Custom Print -الف 

 Print All Page -ب 

 Print Selection -ج 

 Print Current Page -د 

 . ....... حات( در متنی)توض Commentدرج  یبرا -980

 View>New Comment -الف 

 edit>comment -ب 

 Home>New Comment -ج 

 Review>New Comment -د 

 م؟یکن یاز کدام مورد استفاده م Wordط نرم افزار یصفحه در مح ییکردن بزرگنما یسفارش یبرا -981

 Custom -الف 

 Review>Zoom -ب 

 View>Zoom -ج 

 View>Setting -د 

 ست؟یچ Fontکاربرد  -982

 مین کنییم اندازه متن را تعیتوان ینه مین گزیبا استفاده از ا -الف 

 میر دهییرا تغ یم شکل متن انتخابیتوان ینه مین گزیابا استفاده از  -ب 

 میده رییتغ را متن م نوع قلمیتوان ینه مین گزیبا استفاده از ا -ج 

 میکن یم استفاده مورد نیا از متن به دادن فرمت یبرا -د 

 است؟ تر مناسب مورد کدام متن یرو شده اعمال یها فرمت کردن پاک یبرا -983

 Change Case -الف 

 Remove Format -ب 

 Clear All Formatting -ج 

 Delete Formatting -د 

 دهد؟ یانجام م یچه کار Strikethroughدستور  -984

 کند. یک خط درج میمتن  یرو -الف 

 کند. یر متن درج میک خط زی -ب 

 کند. یل و کج میمتن را ما -ج 

 کند. یمتن را توپر م -د 

 ن دستور کدام است؟یع تریا حروف الفبا سریبر اساس عدد نوشته ها  یمرتب ساز یبرا -985

 Filter -الف 
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 Character spacing -ج 

 Line and paragraph spacing -د 

 دارد؟ یچه کاربرد Line and Paragraph Spacingابزار  -1081

 خطوط و پاراگراف یترازبند -الف 

 خطوط و پاراگراف یتورفتگ -ب 

 م فاصله خطوط و پاراگرافیتنظ -ج 

 و پاراگراف دیجاد خطوط جدیا -د 

 د؟یکن یاستفاده م Borderاز ابزار  یچه زمان -1082

 شود یه برگه استفاده میم حاشیتنظ یبرا -الف 

 شود یه جدول استفاده میر حاشییتغ یبرا -ب 

 شود یجاد کادر دور متن و جدول استفاده میا یبرا -ج 

 شود یانتخاب سبک نوشته استفاده م یبرا -د 

1083- Shading رود. ی.............. به کار م.. یبرا 

 م فاصله خط و پاراگرافیتنظ -الف 

 ه و کادریجاد حاشیا -ب 

 متون یمرتب ساز -ج 

 نه داخل کادرین رنگ و طرح زمییتع -د 

 شود؟ یمتن از کدام دستور استفاده م یبندرات و قالبییحذف تغ یبرا -1084

 Remove formatting -الف 

 Clear formatting -ب 

 Delete formatting - ج

 Change formatting -د 

 جاد نمود؟یا ید و سفارشیتوان سبک جدینه میبا استفاده از کدام گز -1085

 Create a new style -الف 

 Define New Style -ب 

 Apply Style -ج 

 ..Save As New Style Set -د 

1086- Apply Styles دهد؟ یانجام م یچه کار 

 کند یجاد مید ایسبک جد -الف 

 کند یسبک قبل را حذف م -ب 



 

 

 میموجود را اعمال کن یم سبک هایتوان یکند و م یجاد مید ایسبک جد -ج 

 کندیش میرایموجود را و یسبک ها -د 

 م؟یر دهییرا تغ tabم نوع یتوان یم یبه چه روش -1087

 خط کش یک کردن رویبا کل -الف 

 change tabنه یانتخاب گز viewاز سربرگ  -ب 

 types of tabنه یانتخاب گز viewاز سربرگ  -ج 

 ها در سمت چپ خط کش tabمربع مربوط به  یک رویبا کل -د 

 م؟یرا انجام ده ید چه عملیها با tabهر کدام از  یاجرا یبرا -1088

 میکن یک میکل یدر مکان دلخواه در خط کش افق -الف 

 با درگ کردن خط کش -ب 

 میفشار یرا م caps lockپ کردن دکمه یتا نیصفحه در ح یرو -ج 

 scroll barبا فشردن دکمه  -د 

 رود؟ ین کردن به کار میوسط چ یکدام تب برا -1089

 Right Tab -الف 

 Bar Tab -ب 

 Center Tab -ج 

 Decimal Tab -د 

1090- Center Tab شود ؟ یگفته م یبه چه نوع تب 

 یتب اعشار -الف 

 تب راست -ب 

 طتب وس -ج 

 تب بار -د 

 م؟ینیگز ینه را بر میجاد تب کدام گزیخط اول پاراگراف در محل ا یجاد تورفتگیا یبرا -1091

 Hanging Indent -الف 

 First Line Indent -ب 

 First Line Tab -ج 

 Decimal Tab -د 

1092- Bar Tab دهد؟ یانجام م یچه کار 

 جاد تبیخط اول پاراگراف در محل ا یجاد تورفتگیا -الف 

 جاد تبیک خط در محل ایقرار دادن  -ب 

 از سمت راست یجاد تب در خط کش افقیا -ج 

 ک راستایقرار دادن اعشار اعداد در  -د 

1093- First Line Indent دارد؟ یچه کاربرد 

 رود. یبه کار م ین کردن اعداد اعشاریوسط چ یبرا -الف 

 رود. یمکل پاراگراف به کار  یجاد تورفتگیا یبرا -ب 

 رود یخط اول پاراگراف به کار م یجاد تورفتگیا یبرا -ج 



 

 

 رود  ین خطوط به کار مید فاصله بجایا یبرا -د 

 م؟یکن ین خطوط و پاراگراف استفاده میر فاصله بییتغ ینه برایکدام گز زا -1094

 Special character -الف 

 Line and paragraph spacing -ب 

 Line and paragraph indent -ج 

 Each character Spacing -د 

 کدام است؟ Findانبر ید میکل -1095

 F3 -الف 

 Ctrl +j -ب 

 Ctrl + R -ج 

 Ctrl + F -د 

 م؟یدا کنیل پیتوان لغت و اصطلاح مورد نظر را در متن فا ینه میتوسط کدام گز -1096

 Find -الف 

 Replace -ب 

 Search -ج 

 Google -د 

 رود؟ یبه کار م ید با متن فعلیک متن جدین کردن یگزیجا یکدام دستور برا -1097

 Replace -الف 

 Find -ب 

 Object -ج 

 Search -د 

دا ی)پ انتخاب کند ینیگزیجا یم ورد آن را برایخواه یرا که م یعبارت Find and Replaceدر قسمت .............. از پنجره  -1098

 م.یسینویکند(، م

 Replace With -لف ا

 Find With -ب 

 Find What -ج 

 Search word -د 

 م؟یسینویچه م Find What ییکشو یدر منو -1099

 ن شدنیگزیجا ید برایمتن جد -الف 

 میم جستجو کنیخواه یکه م یمتن -ب 

 میم توپر کنیخواه یرا که م یمتن -ج 

 میم فرمت آن را پاک کنیخواه یکه م یمتن -د 

 م؟ین شود، درج کنیگزیجا یم با کلمه قبلیخواه یرا که م یدیا عبارت جدید کلمه یکدام کادر با در -1100

 Search Box -الف 

 Find What -ب 

 Replace With -ج 



 

 

 Replace All -د 

 د؟ین کنیگزید تمام کلمات انتخاب شده را جایتوان یم Find and Replaceبا استفاده از کدام دکمه در کادر  -1101

 More -الف 

 Replace All -ب 

 Replace -ج 

 Find what -د 

 شود؟ ینه استفاده میاز کدام گز Find And Replaceدر کادر  یافتن کلمه بعدی یبرا -1102

 Find Previous -الف 

 Replace -ب 

 Find what -ج 

 Find next -د 

 م؟یکن یک میکدام دکمه کل یم روین کنیگزیجا کیک به یشده را به صورت  افتهیم کلمات ینکه بخواهیا یبرا -1103

 Replace All -الف 

 Single Replace -ب 

 Find Next -ج 

 Replace -د 

 د؟یکن یش خط کش کدام سربرگ را انتخاب مینما یبرا -1104

 Reference -الف 

 View -ب 

 Layout -ج 

 Insert -د 

 د؟یکن یرا فعال م Viewخط کش کدام ابزار از سربرگ  یبرا -1105

 Gridline -الف 

 Eraser -ب 

 Ruler -ج 

 Wrap -د 

 م؟یده یر مییتوسط کدام دستور اندازه صفحه را تغ -1106

 Width -الف 

 Paper -ب 

 Page Layout -ج 

 Size -د 

 م؟یده یر میینه را تغیر ارتفاع صفحه کدام گزییتغ یبرا -1107

 Width -الف 

 Weight -ب 

 Height -ج 

 Paper -د 



 

 

 دارد؟ یچه کاربرد Paperدر سربرگ  Widthنه یگز -1108

 دهد یر مییارتفاع صفحه را تغ -الف 

 کند ین مییعرض صفحه را تع -ب 

 کند ین مییاندازه کل صفحه را تع -ج 

 کند ین مییه را تعیدازه حاشان -د 

 کند؟ ین مییجهت صفحه را تع Page Layoutکدام دستور در سربرگ  -1109

 Orientation -الف 

 Margins -ب 

 Size -ج 

 Columns -د 

 شود؟ یز قلم استفاده میکاهش سا یبرا یبید ترکیکدام کل -1110

 + ( Ctrl -الف 

 + ) Crtl -ب 

 + [ Ctrl -ج 

 + ] Ctrl -د 

پ یتا یتشود تا عبارت به درس یموجب م Fontنه از یک عدد به صورت توان عدد قبل از خود، کدام گزینوشتن  یبرا -1111

 شود؟

 Strikethrough -الف 

 Superscript -ب 

 Subscript -ج 

 Engrave -د 

 ر است؟ینه امکان پذیگر توسط کدام گزیا چند پاراگراف دیک یک پاراگراف به ی یکردن قالب بند یکپ -1112

 Format Painter -الف 

 Position -ب 

 Effect -ج 

 Paragraph -د 

 ام است؟کد Go to یبید ترکیکل -1113

 Ctrl +C -الف 

 Ctrl + G -ب 

 Alt +C -ج 

 Alt + G -د 

 م؟یکن یپاراگراف، از کدام سربرگ استفاده م یترازبند یبرا -1114

 Insert -الف 

 Font -ب 

 Page Layout -ج 

 Review -د 



 

 

 کرد؟ استفاده توان یم ریز نهیگز کدام از صورت پشت سر هم انتخاب چند خط به یبرا -1115

 یجهت یدهایهمراه با کلShift  دیکل –الف 

 یجهت یدهایهمراه با کل Altد یکل -ب 

 یجهت یدهایهمراه با کل Ctrlد یکل -ج 

 و انتخاب خطوط Scroll Barد یکل -د 

 شود؟ ید استفاده مید صفحه کلیانتخاب کلمات پراکنده از کدام کل یبرا -1116

 Alt -الف 

 Ctrl -ب 

 Shift -ج 

 Tab -د 

 د؟یوتررا نام ببریکامپ یاصل یظه هاحاف -1117

 CD- ROM - DVDROM -الف 

 ROM - RAM -ب 

 EPROM - HARD DISK -ج 

 HARD DISK- RAM -د 

 است؟ یک دستگاه خروجیکدام مورد  -1118

 دیصفحه کل -الف 

 ماوس -ب 

 اسکنر -ج 

 چاپگر  -د 

 کدام برنامه وظیفه این کار را بر عهده دارد ؟ ،وتربرای تبدیل دستورات غیر قابل فهم  به زبان قابل درک کامپی -1119

 سیستم عامل -الف 

 مترجم ها -ب 

 نرم افزارهای کاربردی -ج 

 نرم افزارهای کمکی -د 

 شود؟ یدر حال پردازش از کدام مورد استفاده م یموقت داده ها ینگهدار یبرا -1120

 CU -الف 

 ALU -ب 

 REGISTER -ج 

 CACHE -د 

 است؟ یوتریستم کامپیک سی یکیزیف یانگر اجزایر بیز ینه هایاز گزک یکدام  -1121

 (HARDWAREسخت افزار ) -الف 

 (FREEWAREگان )ینر م افزار را -ب 

 (SOFTWARE) نرم افزار -ج 

 (COURSEWARE) یموزشآ ابزار –د 

 ح است؟یر صحیز یک از عبارت هایکدام  -1122



 

 

 ت استیک مگابایت کمتراز یگابایک گی -الف 

 . ت استیک مگابایت کمترازیلو بایک کی -ب 

 ت استیک بیت کمترازیک بای -ج 

 ت استیگابایک گیت کمتر ازیک ترابای -د 

 ح است؟یصح  RAMکدام عبارت در مورد -1123

 کند یحفظ م را داده ها شود یوترخاموش میکه کامپ یهنگام RAM -الف 

  است ینوشتن یک حافظه خواندی  RAM -ب 

 است یفظه فقط نوشتنحاRAM -ج 

 ش دادیتوان افزا ینم یوتریچ کامپیرا در ه  RAM -د 

 ابعاد در بین گزینه های زیر کدام است؟ از نظر بزرگ ترین کامپیوتر -1124

 PC -الف 

 MAINFRAME -ب 

 LAPTOP -ج 

 SUPER COMPUTER  -د 

 یک برنامه به منظور اجرا در کجا قرار می گیرد؟ -1125

 RAM  -الف 

 ROM -ب 

 HARD DISK -ج 

 CACHE MEMORY -د 

 ؟باشد ینمر جزء انواع شبکه یک از موارد زیکدام  -1126

 GATE WAYS -الف 

 WAN -ب 

 MAN -ج 

 LAN -د 

 یک سیستم کامپیوتر از چه قسمت هایی تشکیل شده است ؟ -1127

 سخت افزار و حافظه جانبی -الف 

 نرم افزار و میان افزار -ب 

 میان افزار سخت افزار و -ج 

 میان افزار و نرم افزار وسخت افزار  -د 

 شود؟ یر بزرگ استقاده میچاپ نقشه ها و تصاو یاز کدام مورد برا -1128

 پلاترها -الف 

 پرینترها -ب 

 یهای فتوکپدستگاه -ج 

 های تکثیرماشین -د 

 شود؟ یده میع نامیبه عنوان حافظه سر CPUکدام واحد از  -1129

 CACHE -الف 



 

 

 REGISTER -ب 

 CU -ج 

 ALU -د 

 ؟باشد ینم ینه دستگاه ورودیکدام گز -1130

 SPEAKER  -الف 

 MOUSE -ب 

 LIGHT PEN -ج 

 SCANNER -د 

 ؟نیست های زیر ضروریبرای استفاده از صوت و موزیک در کامپیوتر کدام یک از گزینه -1131

 کارت صدا -الف 

 مودم -ب 

 ییدئویا وی یل صوتیفا -ج 

 (SPEAKERلندگو )ب -د 

 چه نام دارد؟ یوتریدر شبکه کامپ یوتر مرکزیکامپ -1132

 MICRO COMPUTER -الف 

 SUPER COMPUTER -ب 

 MINI COMPUTER -ج 

 SERVER COMPUTER  -د 

 ند؟یگو یت ها چه مینترنت در وب سایق شبکه ایبه فروش ازطر -1133

 E- TEJARAT -الف 

 E- COMMERCE -ب 

 E- TRAINING -ج 

 E- BANKING -د 

 ؟عبارت است از یوتریروس کامپیو -1134

 زا یماریروس بیک وی -الف 

 وتریک سخت افزار موجود در کامپی -ب 

  مخرب یوتریک برنامه کامپی -ج 

 وتریک نرم افزار موجود در کامپی -د 

 ؟شود یو مشخص میک درایآزاد  ین عبارت، فضایدر مقابل ا -1135

 CAPACITY -الف 

 BACKUP NOW -ب 

 FREE SPACE  -ج 

 TYPE -د 

 ها و پوشه ها کدام گزینه را انتخاب می نمائیم؟ برای لغو آخرین عمل انجام شده بر روی فایل -1136

 RESTORE -الف 

 CLOSE -ب 



 

 

 UNDO  -ج 

 REDO -د 

 کدام است؟ یمتن یل هایپسوند فا -1137

 TXT  -الف 

 BMP -ب 

 JPG -ج 

 RTF –د 

 شود.ی......... استفاده م ید هایب کلیک برنامه بدون پاسخ از ترکین بست یبرا -1138

 CTRL+ALT+DELET  -الف 

 SHIFT+CTRL+ALT -ب 

 SHIFT+CTRL+A -ج 

 ALT+DELET+Y -د 

 م؟یکن ینه استفاده میپنجره از کدام گز یبه حداقل رساندن اندازه  یبرا -1139

 MINIMIZE  -الف 

 MAXIMIZE -ب 

 CLOSE -ج 

 RESTORE DOWN -د 

 حذف فایل ها و پوشه ها موجب انتقال آنها به کجا می شود؟ -1140

 COMPUTER  -الف 

 RECYCLE BIN -ب 

 از بین می روند -ج 

 قرار می گیرند CLIPBORDدر حافظه موقت  -د 

 استفاده کرد؟توان ینم نهیبستن پنجره ها از کدام گز یبرا -1141

 م .یک کنیرا کل CLOSEنه یگز FILE یاز منو -الف 

 .میک کنیپنجره کل یعلامت ضربدر سمت راست گوشه بالا یرو -ب 

 م .یکن یاستفاده م ALT+ F4 یبید ترکیاز کل -ج 

 م .یکن یاستفاده م ALT+ TAB یبید ترکیاز کل -د 

 ند؟یگو یکه دکمه سمت چپ آن فشرده شده است چه میبه عمل حرکت دادن ماوس در حال -1142

 DRAG  -الف 

 CLICK -ب 

 DOUBLE CLICK -ج 

 DROP -د 

 ند؟یگو یپنجره ها چه م یبالا یبه نوار رنگ -1143

 نوار آدرس -الف 

 نوار منو -ب 

 نوار عنوان -ج 



 

 

 تینوار وضع -د 

 نترنت.یت در ایسا منحصر به فرد هر ی................... عبارت است از نشان -1144

 DOMAIN -الف 

 ADDRESS SITE -ب 

 URL  -ج 

 HTTPS -د 

 باشد؟ یم جستجوگر ک موتوریر ینه زیکدام گز -1145

 varzesh3 -الف 

 GOOGLE -ب 

 sanjesh -ج 

 TVTO -د 

 کدام پوشه در برگیرنده پیام های دریافت شده می باشد؟ -1146

 INBOX  -الف 

 DRAFT -ب 

 OUTBOX -ج 

 SENT ITEM -د 

 ظر موضوعی طبقه بندی شده اند؟سایت هایی هستند که در آن سایتها از ن -1147

 یعیزبان طب یموتور جستجو -الف 

 موتورهای جستجو -ب 

 موتورهای فرا جستجو -ج 

 وب سایتهای فهرست -د 

 نترنت کدام است ؟یخچه ایتار -1148

 BACK -الف 

 HISTORY -ب 

 FAVORITES -ج 

 FORWARD -د 

 را می توان استفاده کرد؟به جای علامت + در جستجوی عبارت ها کدام علمگرد  -1149

 OR -الف 

 AND -ب 

 NOT -ج 

 XOR -د 

 کدام است؟ یمربوط به موسسات دولت یت هایپسوند سا -1150

 COM -الف 

 EDU -ب 

 GOV  -ج 

 MIL -د 



 

 

 شده می باشد؟ م پوشه در برگیرنده پیام های حذفکدا -1151

 INBOX -الف 

 DRAFT -ب 

 OUTBOX -ج 

 TRASH  -د 

 م ؟ید انجام دهیبا یر اندازه متن صفحات وب چه عملییتغ یبرا -1152

 IE/VIEW / TEXT SIZE  -الف 

 IE/ VIEW / STATUS BAR -ب 

 IE/VIEW /EXPLORER BAR -ج 

 IE/ VIEW / TOOL BAR -د 

 کدام یک از نرم افزارهای زیر مرورگر صفحات وب است؟ -1153

 INTERNET EXPLORER -الف 

 MOZILA FIREFOX -ب 

 WINDOWS EXPLORER -ج 

 INTERNET EXPLORER - MOZILA FIREFOX -د 

 ادغام خانه های جدول از کدام گزینه استفاده می کنیم؟ یبرا -1154

 SPILT CELLS -الف 

 MERGE CELLS -ب 

 TABLE  SPILT -ج 

 MERGE TABLE -د 

 است؟ یچه نوع نرم افزار WORDنرم افزار  -1155

 است یکیک نرم افزار گرافی -الف 

 است یک نرم افزار آماری -ب 

 ک نرم افزار واژه پرداز استی -ج 

 ک نرم افزار صفحه گستر استی -د 

 ح است؟یصح WORDد در نرم افزار یجاد سند جدیا یر برایز ینه هایک از گزیکدام  -1156

 OPEN -الف 

 NEW -ب 

 SAVE -ج 

 ..SAVE AS -د 

 شود؟ ینه استفاده میزن خطوط از کدام گیم فاصله بیتنظ یبرا -1157

 LINE COLOR -الف 

 LINE STYLE -ب 

 LINE SPACING -ج 

 BORDER -د 

 م؟یکن ینه استفاده میخطوط پاراگراف تراز شوند از کدام گز یم انتهایاگر بخواه -1158



 

 

 JUSTIFY -الف 

 CENTER -ب 

 ALIGN LEFT -ج 

 ALIGN RIGHT -د 

 شود؟ یاستفاده م یانه یاز چه گز یدرج اشکال هندس یبرا -1159

 SHAPES -الف 

 PICTURE -ب 

 SMART ART -ج 

 CHART -د 

 شود؟ ینه استفاده میاز کدام گز یبه افق یر سند از حالت عمودییتغ یبرا -1160

 PORTRAIT -الف 

 PORTRAIT FLEEPED -ب 

 LANDSCAPE -ج 

 LANDSVCAPE FLEEPED -د 

 ل به چند خانه استفاده می شود؟از کدام فرمان برای تقسیم یک خانه جدو -1161

 INSERTاز سربرگ  SPLITگزینه  -الف 

 LAYOUTاز سربرگ   SPLIT CELLSگزینه   -ب 

 INSERTاز سربرگ  MERGEگزینه  -ج 

 LAYOUTاز سربرگ وابسته   MERGEگزینه  -د 

 جاد شده به صورت الگو کدام است؟یسند ا یره یپسوند ذخ -1162

 PDF -الف 

 DOTX -ب 

 DOCX -ج 

 XPS -د 

 کدام ابزار مناسب است؟ یست علامت گذاریل جادیجهت ا -1163

 BULLETS -الف 

 NUMBERING -ب 

 TABLE -ج 

 SYMBOL -د 

 کدام است؟ REDO یبید ترکیمعادل کل -1164

 CTRL+B -الف 

 CTRL+Y -ب 

 CTRL+Z -ج 

 CTRL+SHIFT+Z -د 
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